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Intel Software License Agreement 

IMPORTANT - READ BEFORE COPYING, INSTALLING OR USING. 

Do not use or load this software and any associated materials (collectively, the 
“Software”) until you have carefully read the following terms and conditions. By 
loading or using the Software, you agree to the terms of this Agreement. If you do not 
wish to so agree, do not install or use the Software. 

LICENSE. This Software is licensed for use only in conjunction with Intel component 
products. Use of the Software in conjunction with non-Intel component products is not 
licensed hereunder. 

Subject to the terms of this agreement, Intel grants to you a nonexclusive, 
nontransferable, worldwide, fully paid-up license under Intel’s copyrights to: 

a) use, modify and copy Software internally for your own development and 
maintenance purposes; and 

b) modify, copy and distribute Software, including derivative works of the Software, 
to your end-users, but only under a license agreement with terms at least as 
restrictive as those contained in Intel's Final, Single User License Agreement, 
attached as Exhibit A; and 

c) modify, copy and distribute the end-user documentation which may accompany 
the Software, but only in association with the Software. 

If you are not the final manufacturer or vendor of a computer system or software 
program incorporating the Software, then you may transfer a copy of the Software, 
including derivative works of the Software (and related end-user documentation) to 
your recipient for use in accordance with the terms of this agreement, provided such 
recipient agrees to be fully bound by the terms hereof. You shall not otherwise assign, 
sublicense, lease, or in any other way transfer or disclose Software to any third party. 
You shall not reverse-compile, disassemble or otherwise reverse-engineer the 
Software. 

Except as expressly stated in this agreement, no license or right is granted to you 
directly or by implication, inducement, estoppel or otherwise. Intel shall have the right 
to inspect or have an independent auditor inspect your relevant records to verify your 
compliance with the terms and conditions of this agreement. 

CONFIDENTIALITY. If you wish to have a third party consultant or subcontractor 
("Contractor") perform work on your behalf which involves access to or use of 
Software, You shall obtain a written confidentiality agreement from the Contractor 
which contains terms and obligations with respect to access to or use of Software no 
less restrictive than those set forth in this agreement and excluding any distribution 
rights, and use for any other purpose. Otherwise, you shall not disclose the terms or 
existence of this agreement or use Intel's name in any publications, advertisements, 
or other announcements without Intel's prior written consent. You do not have any 
rights to use any Intel trademarks or logos. 
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OWNERSHIP OF SOFTWARE AND COPYRIGHTS. Title to all copies of the Software 
remains with Intel or its suppliers. The Software is copyrighted and protected by the 
laws of the United States and other countries, and international treaty provisions. You 
may not remove any copyright notices from the Software. Intel may make changes to 
the Software, or to items referenced therein, at any time and without notice, but is 
not obligated to support or update the Software. Except as otherwise expressly 
provided, Intel grants no express or implied right under Intel patents, copyrights, 
trademarks, or other intellectual property rights. You may transfer the Software only if 
the recipient agrees to be fully bound by these terms and if you retain no copies of the 
Software. 

LIMITED MEDIA WARRANTY.  If the Software has been delivered by Intel on physical 
media, Intel warrants the media to be free from material physical defects for a period 
of ninety (90) days after delivery by Intel. If such a defect is found,return the media 
to Intel for replacement or alternate delivery of the Software as Intel may select. 

EXCLUSION OF OTHER WARRANTIES. EXCEPT AS PROVIDED ABOVE, THE SOFTWARE 
IS PROVIDED "AS IS" WITHOUT ANY EXPRESS OR IMPLIED WARRANTY OF ANY KIND 
INCLUDING WARRANTIES OF MERCHANTABILITY, NONINFRINGEMENT, OR FITNESS 
FOR A PARTICULAR PURPOSE.  Intel does not warrant or assume responsibility for the 
accuracy or completeness of any information, text, graphics, links or other items 
contained within the Software. 

LIMITATION OF LIABILITY. IN NO EVENT SHALL INTEL OR ITS SUPPLIERS BE LIABLE 
FOR ANY DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, LOST 
PROFITS, BUSINESS INTERRUPTION, OR LOST INFORMATION) ARISING OUT OF THE 
USE OF OR INABILITY TO USE THE SOFTWARE, EVEN IF INTEL HAS BEEN ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS PROHIBIT 
EXCLUSION OR LIMITATION OF LIABILITY FOR IMPLIED WARRANTIES OR 
CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT 
APPLY TO YOU. YOU MAY ALSO HAVE OTHER LEGAL RIGHTS THAT VARY FROM 
JURISDICTION TO JURISDICTION. 

TERMINATION OF THIS AGREEMENT. Intel may terminate this Agreement at any time 
if you violate its terms. Upon termination, you will immediately destroy the Software 
or return all copies of the Software to Intel. 

APPLICABLE LAWS. Claims arising under this Agreement shall be governed by the laws 
of California, excluding its principles of conflict of laws and the United Nations 
Convention on Contracts for the Sale of Goods. You may not export the Software in 
violation of applicable export laws and regulations. Intel is not obligated under any 
other agreements unless they are in writing and signed by an authorized 
representative of Intel. 

GOVERNMENT RESTRICTED RIGHTS. The Software is provided with  

"RESTRICTED RIGHTS." Use, duplication, or disclosure by the Government is subject 
to restrictions as set forth in FAR52.227-14 and DFAR252.227-7013 et seq. or their 
successors. Use of the Software by the Government constitutes acknowledgment of 
Intel's proprietary rights therein. Contractor or Manufacturer is Intel Corporation, 
2200 Mission College Blvd., Santa Clara, CA 95052. 

§ 
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1 Introduction 

1.1 About This User’s Guide 

This document is intended for Original Equipment Manufacturers (OEM) and System 
Integrators. It introduces and provides details on the use of the various configuration 
and tuning support tools for Intel® Quiet System Technology (Intel® QST). The tools 
are included in the various Intel® Management Engine (Intel® ME) firmware kits 
provided by Intel. These tools are provided to facilitate the configuration and fine 
tuning of the Intel® QST subsystem.  

For additional information on Intel® QST configuration and fine tuning, refer to the 
latest version of the Intel® Quiet System Technology Configuration and Tuning 
Manual. 

1.2 Terminology 
 

Term Description 

Intel® QST Intel® Quiet System Technology 

Intel® ME 
Intel® Management Engine; an embedded processor located within 
the PCH 

Firmware (FW) Embedded firmware running on the Intel® ME 

ATX Advanced Technology eXtended form factor. 

BTX Balanced Technology eXtended form factor. 

Graphic User Interface 
(GUI) 

A visual framework that allows the user to interact with an application 
through direct manipulation of graphics objects. 

DTS Digital Thermal Sensor reports a relative die temperature as an offset 
from TCC activation temperature. 

§ 
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2 Tools Overview 

Intel provides this collection of tools and utilities to enhance the ease-of-use of the 
configuration and tuning processes for Intel® QST. The tools and utilities provided 
include: 

1. Configuration Management Tools – A collection of tools that are used by 
OEM/ODM and System Integrators to create, edit, install and extract Intel® 
QST configuration files. Individually, they are used as follows: 

a. QSTCT_GUI.exe – Windows executable for the Intel® QST Configuration 
GUI, a tool that supports the editing of QST Configuration (INI) files. See 
xxxx for more information on the use of this tool. 

b. QstConfigurationWizard.msi – Installation package for the QST 
Configuration Wizard, which provides support for creating new QST 
Configuration (INI) files with a minimum of user input.  

c. QstCfgD.exe/QstCfg.exe – Dos and Windows executables, respectively, 
for a tool that supports either the immediate installation of a QST 
Configuration (INI) file or the creation of a file containing a QST Binary 
Configuration Payload that can be subsequently installed (included in ME 
(SPI) flash images). 

d. QstINID.exe/QstINI.exe – DOS and Windows executables, 
respectively, for a tool that supports the extraction of the currently-
installed QST Payload and the reconstitution of a QST Configuration (INI) 
file from it. 

e. QstCfgATXIP.ini – Default Intel® QST Configuration (INI) file for Intel® 5 
Series Chipset based platforms. It is configured for the hardware that is 
present on the Customer Reference Board (CRB). It is provided as a 
starting point for the derivation of customer versions. 

2. Configuration Tuning Tools – A collection of tools that are used by 
OEM/ODM and System Integrators to support both manual and automated fine 
tuning of Intel® QST configurations. Individually, they are used as follows: 

a. QstTuningWizard.msi – Installation package for the QST Tuning Wizard, 
which automatically tunes the Fan Weighting Matrix and assists with the 
tuning of the Processor Temperature Response coefficients. 

b. QstLog.exe – Windows executable for a command-line tool that is used 
to display and collect (log) readings from the fan speed controllers and the 
temperature, fan speed and (optionally) voltage and current sensors. The 
comma-delimited log files produced can be input to various tools, 
including Microsoft* Excel, for subsequent analysis. 

c. QstCtrl.exe – Windows executable for an interactive command-line tool 
that can be used to manually control fan speed, display sensors/controller 
readings/settings and have Intel® QST perform fan redetection. 
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d. QstStaDt.exe/QstStat.exe – DOS and Windows executables, 
respectively, for a command-line tool that is used to obtain a report of the 
status of the Intel® QST Subsystem and the sensors and fan speed 
controllers being managed by it. 

e. QstDtsD.exe/QstDts.exe – DOS and Windows executables for a 
command-line tool that is used to test specific sets of parameters, before 
they are committed into a BIOS, for the new, DTS-based thermal 
management control capability utilized with the latest Intel processors. 

3. Compliancy Test Tool – This executable (QstCply.exe) is used to check the 
readiness of an Intel® QST-based system. 

4. System Tools – These tools facilitate the Intel® QST configuration process. 
Individually, they are used as follows: 

a. Fitc.exe – This tool is used to combine individual images – the BIOS 
firmware, the Intel® QST (Management Engine) firmware and Intel® QST 
Configuration Payload – into a single image for the SPI flash. 

b. Fpt.exe – This tool is used to write an image to SPI flash or update an 
image in the SPI flash device. 

Note: This document does not cover how to use the system tools. For details on how to use 
the system tools (Fitc and Fpt), refer to the System Tools User’s Guide included in the 
Management Engine firmware kit. 

2.1 Configuration Management Tools 

This collection of tools provides support for the creation, edit, installation and 
extraction of Intel® QST Configuration (INI) files. The use of these tools is 
documented in the subsequent sections. The QST Configuration GUI is documented 
separately in Chapter 3 and the QST Configuration Wizard is documented separately in 
Chapter 4. 

2.1.1 QstCfgD.exe/QstCfg.exe 

QstCfgD.exe: Pure DOS command line tool. The tool is supported on Free DOS and 
Windows 98 DOS.  

QstCfg.exe: Windows command line tool. The tool is supported on Windows 2000 
SP4, Windows XP SP1, Windows XP SP2, Windows XP 64, Windows Vista and Windows 
7. 
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2.1.1.1 Usage 

The Configuration Tool can be utilized to achieve different goals, including: 

1) Initially configuring the Intel® QST subsystem: The Configuration Tool can generate 
a binary payload from an INI file containing initial control parameters. The binary 
payload can then be programmed into the SPI flash to configure Intel® QST 
subsystem. 

2) Tuning Intel® QST subsystem: after initially configuring the Intel® QST subsystem, 
the parameters in the INI file can be modified and optimized, based upon specific 
system design and thermal characteristics, to achieve optimum performance of the 
Intel® QST Subsystem. The Configuration Tool can be used to deliver INI files with 
optimized settings to the ME for subsequent storage in the SPI flash. The 
Configuration Tool can be easily integrated into the factory floor tool/application to 
automatically store the final settings into the SPI flash of production systems in 
manufacturing line processes. 

3) Intel® QST testing and validation: during testing, validation and tuning of the 
Intel® QST subsystem, control parameters may need to be changed often, in order to 
optimize Intel® QST performance. The Configuration Tool provides an easy way to 
update the settings of the Subsystem. 

2.1.1.2 Invocation 

The primary environments for the execution of the Configuration Tool is the Windows* 
O/S and DOS. The Configuration Tool takes an INI file containing configuration 
settings and generates a binary payload from it. This Payload can be sent directly to 
the Management Engine, for immediate application, or written to a file, for subsequent 
application. Binary payload files so produced can be included in SPI flash images. A 
system configured this way will have this configuration applied immediately after the 
system is powered up for the first time. 

The Configuration Tool will execute from the command line. Its operation is defined as 
follows: 

1. The Tool will parse the configuration contained within the specified INI file and 
verify its contents. If an error is detected, a report will be generated and the 
program’s execution terminated. 

2. If the Tool successfully parses the configuration, it will prepare a binary payload 
and either deliver it to the ME or write it to a file. If it is delivered to the ME, the 
results of the ME’s processing of this payload will be output. If the payload is 
rejected by the ME, information about the parameter that caused it to be rejected 
will be displayed. 

Note: The Tool directs its output (status updates, error messages, etc.) to the standard 
output stream (STDOUT; normally the console). If the command line redirects the 
program’s output to a (log) file, the program will also duplicate its output to the 
standard error stream (STDERR; always the console). This ensures that the operator 
always sees the results of the operation, even if it is also written to a (log) file. 
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The syntax for the tool is defined as follows: 

QstCfgD [<INI File Path>] [{-d|{-w|-o} [<Binary File Path>]}] 

QstCfg [<INI File Path>] [{-d|{-w|-o} [<Binary File Path>]}] 

Where: 

INI File Path  Specifies the pathname for the INI file. 

-d Specifies that the tool is to wait (delay 
termination) until QST has completed its fan 
detection process. 

-w [<Binary File Path>] Specifies that the payload is to be written to a file. 
If this file already exists, the tool will request 
confirmation before overwriting it.  

-o [<Binary File Path>] Specifies that the payload is to be written to a file. 
If the file already exists, it will be overwritten. 

Note: 

• If the optional INI File Path is not specified, the default pathname for the INI file 
will be “QstCfg.ini”. 

• If the optional Binary File Path is not specified, the default pathname for the 
Payload file will be “QstCfg.bin”.  

• The “-d” parameter and the “–w”/“–o” parameters are mutually exclusive. If “-
w” or “-o” is specified, “-d” cannot be specified. 

• The “-w” parameter and the “-o” parameter are mutually exclusive. Only one of 
them may be specified. 

• The tool also supports two additional parameters, “-e” and “-c”, that are used for 
testing purposes. Customers should not use these parameters. 

2.1.1.3 Examples 

1. “qstcfg”: Specifies that the configuration contained within file “Qstcfg.ini” will be 
parsed and, if no errors are detected, delivered to the ME for processing. 

2. “qstcfg config.ini -d”: Specifies that the configuration contained within file 
“config.ini” will be parsed and, if no errors are detected, delivered to the ME for 
processing. The tool will wait to terminate until the fan detection process is 
completed. 

3. “qstcfg –o”: Specifies that the configuration contained within file “qstcfg.ini” will 
be parsed and, if no errors are detected, written to file “qstcfg.bin”. If file 
“qstcfg.bin” already exists, it will be overwritten. 

4. “qstcfg config.ini –o config.bin”: Specifies that the configuration contained 
within file “config.ini” will be parsed and, if no errors are detected, written to file 
“config.bin”. If file “config.bin” already exists, it will be automatically overwritten. 
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2.1.2 QstINID.exe/QSTINI.exe 

This tool provides support for a level of post-mortem analysis of the Intel® QST 
Subsystem configuration. It provides the ability to reconstitute an INI file from a 
binary configuration payload. This payload may be read from a file (created previously 
using QstCfg.exe/QstCfgD.exe) or it may be obtained from the Intel® QST Subsystem. 
Once an INI file has been reconstituted, it can be compared to other INI files, in order 
to determine whether any differences are present or, in the latter case, to verify that 
the configuration in use by the Intel® QST Subsystem is as expected. 
 
QstINID.exe: Pure DOS command line tool. The tool is supported on Free DOS and 
Windows* 98 DOS.  

QstINI.exe: Windows command line tool. The tool is supported on Windows 2000 
SP4, Windows XP SP1, Windows XP SP2, Windows XP 64, Windows Vista and Windows 
7. 

2.1.2.1 Invocation 

The tool is an executable file for either the Windows or DOS environment. It executes 
in from the command line. Its command line syntax is defined as follows: 

QstINID [-P <Payload-Path>] [-I <INI-Path>] 

QstINI [-P <Payload-Path>] [-I <INI-Path>] 

Where: 

-P <Payload-Path> Specifies the pathname for a Binary Payload File. If one is 
specified, the INI file will be reconstituted from its contents. 
If no path is specified, the current Configuration Payload will 
be obtained from the Intel® QST Subsystem and used to 
reconstitute the INI file.  

-I <INI-Path> Specifies the pathname for the resulting INI file. If no 
pathname is specified, default pathname “QstCfg.ini” will be 
used. 

2.1.2.2 Examples 

1. “QstINI”: Specifies that the current configuration payload is to be retrieved from 
the Intel® QST Subsystem and written to an INI file named “QstCfg.ini”. 

2. “QstINI –I Config.ini”: Specifies that the current configuration payload is to be 
retrieved from the Intel® QST Subsystem and written to an INI file named 
“Config.ini”. 

3. “QstINI –P Config.bin”: Specifies that the configuration payload contained 
within file “Config.bin” is to retrieved and written to an INI file named “QstCfg.ini”. 

4. “QstINI –P Config.bin –I Config.ini”: Specifies that the configuration payload 
contained within file “Config.bin” is to retrieved and written to an INI file named 
“Config.ini”. 



 
Tools Overview 
 
 

  Intel Confidential 15 

2.2  Configuration Tuning Tools 

This collection of tools provides support for the fine tuning of Intel® QST 
Configurations. It allows the user to determine the best way to map sensors to fans 
and to determine the weighting of each fan response. They can be used with any 
system form factor and any number of fans and sensors. 

The Intel® QST Tuning Wizard is the primary tool for the tuning of Intel® QST 
configurations; the other tools support subsequent monitoring and analysis of the 
tuned configuration. The QST Tuning Wizard is separately documented in Chapter 5; 
the following sections detail the usage of the other tools. 

Note: For more information on the fine-tuning process, refer to the latest Intel® Quiet 
System Technology Configuration and Tuning Manual. Contact your Intel 
representative to obtain a copy of this document. 

2.2.1 QstLog.exe – Reading/Setting Logging Tool 

This tool provides support for the periodic collection of readings from the Temperature 
and Fan Speed Sensors and duty cycle values from the Fan Speed Controllers. 
Optionally, voltage and current sensor readings may be collected as well. The tool will 
sample the available Sensors and Controllers once per second and output the readings 
and settings both to the log file and to the display. 

QstLog.exe: Windows command line tool. The tool is supported on Windows 2000 
SP4, Windows XP SP1, Windows XP SP2, Windows XP 64, Windows Vista and Windows 
7. 

2.2.1.1 Invocation 

The tool is an executable file working in Windows environment. It executes in from the 
command line. Its command line syntax is defined as follows: 

QstLog [–L <Log-Path>] [-M] [–T <Samples>] [–V] [–C] 

Where: 

–L <Log-Path> Specifies the pathname for the log file. This file will be 
overwritten. No warning of overwrite will be provided. Note:
 If no Pathname is provided, the default pathname will be 
“QstLog.txt” 

–M Specifies that the sample set collected in each one-second 
period is to be output to the console on a separate display 
line. 

–T <Samples> Specifies that the program is to terminate after logging the 
specified number of sampled reading sets. 

–C Specifies that readings from current sensors are to be included 
in the data displayed and logged. By default, only 
temperatures, fan speeds and fan duty cycles are collected, 
displayed and logged. 
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 –V Specifies that readings from voltage sensors are to be included 
in the data displayed and logged. By default, only 
temperatures, fan speeds and fan duty cycles are collected, 
displayed and logged. 

Example: “C:\Program Files\Qst\QstLog.exe” –L “C:\QstLog.txt” 

This command will display the readings of temperatures, fan speeds and fan duty 
cycles of the available sensors and fan controllers. Also, the readings will be saved in 
file QstLog.txt in the root directory of drive C. 

2.2.1.2 Operation 

1. The tool will first verify that the Intel® QST Subsystem is configured. If it is not, 
operation cannot continue. 

2. The tool will enumerate the supported sensors and controllers. Labels describing 
the usage for the sensors will be output to the log file (in the same order that 
readings/settings will be output). As well, terse labels will also be output to the 
console window. 

3. Readings will be sampled from all available Sensors and Duty Cycle values will be 
sampled from all available Fan Speed Controllers. The readings will be output to 
the log file as well as to the console display. A sequence number is also included 
in the log file data. 

4. Step 4 will be repeated, once per second, until a key press is detected or until the 
specified number of sample sets has been collected. 

5. When a key is pressed, the log file will be closed. A summary, providing minimum, 
maximum and average readings and duty cycle values will be output to the 
console. 

6. The tool will wait for the <enter> key to be pressed before terminating. This will 
provide the operator with an opportunity to peruse the summary information 
generated. 
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2.2.2 QstCtrl.exe – Manual Fan Control Tool 

This tool provides support for manually specifying the (duty cycle) settings for the Fan 
Speed Controllers. It also provides support for the display of configuration and 
reading/setting information for Temperature, Voltage, Current and Fan Speed Sensors 
and for Fan Speed Controllers. 

QstCtrl.exe: Windows command line tool. The tool is supported on Windows 2000 
SP4, Windows XP SP1, Windows XP SP2, Windows XP 64, Windows Vista and Windows 
7. 

2.2.2.1 Commands 

The tool runs in interactive mode, providing a command prompt and allowing the 
operator to perform multiple operations. Operation will continue until the operator 
enters an exit command. QstCtrl will be initiated from the command line. It has no 
command-line parameters.  

QstCtrl will support the following internal commands: 

A <ctrl> Requests that the specified Fan Speed Controller be placed in 
automatic control mode. The Intel® QST Subsystem will determine 
the Duty Cycle values to be utilized. 
(Example: “A 1” – put Fan Speed Controller #1 in automatic 
mode.) 

C Requests the display of information about all Fan Speed 
Controllers. 

E Requests that the tool terminate. 

M <ctrl> <duty> Requests that the Duty Cycle output of the specified Fan Speed 
Controller be manually set to the specified value. For example, 
command “M 1 50” requests that Fan Controller 1 be operated at 
50% duty cycle. 
(Example: “M 2 50” – Fan speed controller #1 is manually 
set to 50% duty cycle.)  

R Requests that a fan redetection operation is to be performed. 

S Requests the display of information about all Sensors. 

S C Requests the display of information about all Current Sensors. 

S F Requests the display of information about all Fan Speed Sensors. 

S T Requests the display of information about all Temperature 
Sensors. 

S V Requests the display of information about all Voltage Sensors. 
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2.2.3 QstStatD.exe/QstStat.exe – Status Tool 

This tool generates a report detailing the status of the Intel® QST Subsystem. Based 
upon the command-line parameters specified, both terse and verbose reports can be 
produced: 

• The terse report includes a status summary for the Intel® QST Subsystem and 
status and current readings/settings for each sensor and fan speed controller that 
is presently enabled in the Intel® QST configuration. 

• The verbose report includes a detailed breakdown of the status of the Intel® QST 
Subsystem and a detailed display of the configuration parameters and current 
status and readings/settings for each sensor and fan speed controller that is 
presently enabled in the Intel® QST configuration. The detailed status breakdown 
for the Intel® QST Subsystem includes information about the revision and 
capabilities of the Intel® QST firmware and the configuration that was specified by 
the BIOS, including Lock Mask settings, the configuration update for each 
processor present and any fan configuration updates that were specified. 

QstStatD.exe: Pure DOS command line tool. The tool is supported on Free DOS and 
Windows 98 DOS.  

QstStat.exe: Windows command line tool. The tool is supported on Windows 2000 
SP4, Windows XP SP1, Windows XP SP2, Windows XP 64, Windows Vista and Windows 
7. 

2.2.3.1 Invocation 

The tool is an executable file for either the Windows or DOS environment. It executes 
in from the command line. Its command line syntax is defined as follows: 

QstStatD [-V] 

QstStat [-V]  

Where: 

–V Specifies that a verbose report is desired. 
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2.2.3.2 Sample Reports 

This section provides samples of the typical reports produced by the QstStat tool. 
These samples were collected on the Intel CRB board. 

Sample report when run in the normal (non-verbose) mode: 

 
    Intel(R) Quiet System Technology Status Display v2.0.2.9906 
    Copyright (C) 2006-2009, Intel Corporation. All Rights Reserved. 
 
    The QST Subsystem is configured and operational 
 
    Sensor Configuration/Status Summary: 
 
       Processor Temperature                     Normal           49.48 
       Peripheral Controller Hub (PCH) Temper... Normal           44.00 
       Motherboard Temperature                   Normal           29.18 
 
       Processor Fan                             Normal             973 
 
       +12 Volts                                 Normal          11.991 
       +5 Volts                                  Normal           5.030 
       +3.3 Volts                                Normal           3.307 
       Memory Controller Hub Vcc                 Normal           1.058 
       Processor Vcc                             Normal           1.045 
 
    Fan Speed Controller Configuration/Status Summary: 
 
       Processor Fan Controller                  Normal          20.00% 
       Chassis Inlet Fan Controller              Normal          20.00% 
       Chassis Outlet Fan Controller             Normal          20.00% 
       Chassis Outlet Fan Controller             Normal          20.00% 
 

Sample report when run in the verbose mode: 

 
    Intel(R) Quiet System Technology Status Display v2.0.2.9906 
    Copyright (C) 2006-2009, Intel Corporation. All Rights Reserved. 
     
    QST Subsystem Information: 
     
       Firmware Revision:            6.0.0.9290 
     
       Firmware Capabilities: 
     
          Max Temperature Sensors:   12 
          Max Fan Speed Sensors:     8 
          Max Voltage Sensors:       8 
          Max Current Sensors:       0 
          Max Temperature Response:  12 
          Max Fan Speed Controllers: 8 
     
    The QST Subsystem is configured and operational 
     
    Current Lock Mask: 
     
       Configuration:                Unlocked 
       Health Thresholds:            Unlocked 
       Manual Fan Control:           Unlocked 
       SST Bus Resources:            Read-Write 
       Chipset Resources:            Read-Write 
     
    Successful configuration attempt recorded 
     
    Configuration Update for CPU 1: 
     
       Reading Format:               Absolute 
       MCH Temperature Supported:    False 
       Tcontrol Value:               89.00 
       Correction Offset:            0.00 
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       Correction Slope:             1.00 
     
       Temperature Response: 
     
          Proportional Gain:         0.00 
          Integral Gain:             0.00 
          Integral Time Window:      0 
          Derivative Gain:           0.00 
          Derivative Time Window:    0 
     
    No CPU DTS Configuration Updates Received 
     
    No Fan Configuration Updates Received 
     
    Sensor Configuration/Status Summary: 
     
       Temperature Sensor 1: 
     
          Health:                    Normal 
          Usage:                     Processor Temperature 
          Temp:                      49.46 
     
          NonCrit:                   95.00 
          Crit:                      97.00 
          NonRecov:                  99.00 
     
       Temperature Sensor 3: 
     
          Health:                    Normal 
          Usage:                     Peripheral Controller Hub (PCH) Temperature 
          Temp:                      45.00 
     
          NonCrit:                   113.00 
          Crit:                      117.00 
          NonRecov:                  121.00 
     
       Temperature Sensor 5: 
     
          Health:                    Normal 
          Usage:                     Motherboard Temperature 
          Temp:                      29.39 
     
          NonCrit:                   80.00 
          Crit:                      85.00 
          NonRecov:                  90.00 
     
       Fan Speed Sensor 1: 
     
          Health:                    Normal 
          Usage:                     Processor Fan 
          Speed:                     1003 
     
          NonCrit:                   300 
          Crit:                      250 
          NonRecov:                  200 
     
       Voltage Sensor 1: 
     
          Health:                    Normal 
          Usage:                     +12 Volts 
          Volts:                     11.992 
     
          NonCrit Low:               11.400 
          Crit Low:                  11.100 
          NonRecov Low:              10.800 
     
          NonCrit High:              12.600 
          Crit High:                 12.900 
          NonRecov High:             13.200 
     
       Voltage Sensor 2: 
     
          Health:                    Normal 
          Usage:                     +5 Volts 
          Volts:                     5.031 
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          NonCrit Low:               4.750 
          Crit Low:                  4.625 
          NonRecov Low:              4.500 
     
          NonCrit High:              5.250 
          Crit High:                 5.375 
          NonRecov High:             5.500 
     
       Voltage Sensor 3: 
     
          Health:                    Normal 
          Usage:                     +3.3 Volts 
          Volts:                     3.306 
     
          NonCrit Low:               3.135 
          Crit Low:                  3.053 
          NonRecov Low:              2.970 
     
          NonCrit High:              3.465 
          Crit High:                 3.548 
          NonRecov High:             3.630 
     
       Voltage Sensor 4: 
     
          Health:                    Normal 
          Usage:                     Memory Controller Hub Vcc 
          Volts:                     1.059 
     
          NonCrit Low:               1.000 
          Crit Low:                  0.950 
          NonRecov Low:              0.900 
     
          NonCrit High:              1.100 
          Crit High:                 1.150 
          NonRecov High:             1.200 
     
       Voltage Sensor 5: 
     
          Health:                    Normal 
          Usage:                     Processor Vcc 
          Volts:                     1.047 
     
          NonCrit Low:               0.646 
          Crit Low:                  0.546 
          NonRecov Low:              0.446 
     
          NonCrit High:              1.246 
          Crit High:                 1.346 
          NonRecov High:             1.446 



 
Tools Overview 

 
 

22  Intel Confidential  

     
    Fan Speed Controller Configuration/Status Summary: 
     
       Fan Speed Controller 1: 
     
          Health:                    Normal 
          Usage:                     Processor Fan Controller 
          Control:                   Automatic 
          Duty:                      20.00 
     
       Fan Speed Controller 2: 
     
          Health:                    Normal 
          Usage:                     Chassis Inlet Fan Controller 
          Control:                   Automatic 
          Duty:                      20.00 
     
       Fan Speed Controller 3: 
     
          Health:                    Normal 
          Usage:                     Chassis Outlet Fan Controller 
          Control:                   Automatic 
          Duty:                      20.00 
     
       Fan Speed Controller 4: 
     
          Health:                    Normal 
          Usage:                     Chassis Outlet Fan Controller 
          Control:                   Automatic 
          Duty:                      20.00 
     
     
    End of Report 
 

2.3 QstDtsD.exe/QstDts.exe – Process DTS 
Configuration Test 

This tool allows the user to configure parameters of the Intel® QST Subsystem 
relating to the DTS-based thermal management specification.  The command-line 
parameters allow the user to install settings from an INI file or extract the current 
settings to an INI file or the display.  An option to create binary files that can be used 
by the System BIOS to configure the Intel® QST Subsystem can also be generated.  
This tool only operates on the UpdateCPUConfiguration and UpdateDTSConfiguration 
command data. 

QstDtsD.exe:  Pure DOS command line tool. The tool is supported on Free DOS and 
Windows* 98 DOS. 

QstDts.exe:  Windows command line tool. The tool is supported on Windows 2000 
SP4, Windows XP SP1, Windows XP SP2, Windows XP 64, Windows Vista and Windows 
7. 

2.3.1.1 Invocation 

The tool is an executable file for either the Windows or DOS environment. It executes 
in from the command line. Its command line syntax is defined as follows: 

QstDtsD [<FileName>] {-I|-E|-D|-B|-T} [-V] 

QstDts [<FileName>] {-I|-E|-D|-B|-T} [-V] 
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Where: 

FileName This parameter specifies the INI file name that should be used 
for input or output.  Depending on the type of operation being 
performed the file extension may be modified.  If this 
parameter is excluded “QstDts.ini” will be used as the default 
file name. 

-I This option is used to install settings to the Intel® QST 
Subsystem based on the values in the input INI file.  The INI 
file can be specified using the FileName parameter. 

-E This option is used extract the current settings from the 
Intel® QST Subsystem and write them to an INI file.  The INI 
file can be specified using the FileName parameter.  Any 
existing file will be overwritten. 

-D This option displays the current DTS settings of the Intel® 
QST Subsystem. 

-B This option generates a set of binary files that contain the 
BIOS command data used to configure the Intel® QST 
Subsystem with the values in the input INI file.  The output 
files are based off of the FileName parameter.  CPU updates 
will have the file name format of “FileName_CPU#.bin” and 
DTS updates will have the file name format of 
“FileName_DTS#.bin”. 

-T This option is used to generate a template INI file.  The INI file 
can be specified using the FileName parameter. 

-V This option allows for additional information to be displayed for 
a specific operation.  Not all operations provide additional 
output. 

2.3.1.2 Examples 

 

1. “QstDts –T”: Specifies that a template INI file should be generated as a file 
named “QstDts.ini”. 

2. “QstDts –I Dts.ini”: Specifies that the values in the file “Dts.ini” should be 
installed on the Intel® QST Subsystem. 

3. “QstDts –D”: Specifies that the current values used by the Intel® QST 
Subsystem should be displayed on the screen. 

4. “QstDts –E”: Specifies that the current settings used by the Intel® QST 
Subsystem should be extracted and written to a file named “QstDts.ini”. 

5. “QstDts –B Dts.ini”: Specifies that the settings in the file “Dts.ini” should be 
converted into the files “Dts_CPU1.bin” and “Dts_DTS1.bin”.  This assumes that 
the input INI file contains an enabled entries for both CPU1ConfigUpdate and 
Processor1DTSUpdate.  These binary files contain the commands to be sent by the 
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System BIOS to configure the Intel® QST Subsystem as expressed in the input 
INI file. 

2.3.2 MAXPower 

The MAXPower tools run the processor at designated loads. There is a separate 
MAXPower tool (.exe execution file) for each processor. Make sure that the right 
version(s) of the tool are installed for the target processor(s). 

After installing the MAXPower program (double click on the .exe file), the desired load 
can be set by choosing:  Options  Workload Configuration. 

Note: It is recommended that the MAXPower tools be installed to their default installation 
folders. 

2.4 Intel® QST Compliancy Test Tool 

This tool checks the readiness of the QST-enabled platform by performing the 
following tests: General Chipset tests, Intel® Management Engine Interface Device 
tests, Chipset Thermal device tests, Intel® Management Engine Interface tests, Intel® 
Management Engine Firmware tests and Intel® QST tests. 

At the end of the test, the tool will output PASS/FAIL results for each area tested. 

QstCply.exe:  Pure DOS command line tool. The tool is supported on Free DOS and 
Windows* 98 DOS. 

2.4.1 Invocation 

The tool is executed in pure DOS and support Free DOS and Windows 98. Its 
command line syntax is defined as follows: 

QstCply [/?] [/a] [/d] [/p] [/t] [/verbose] [/Exp] 
(Ex : QstCply /a /t) 

Where: 

/?   Display help 

/a   Dump Intel® QST Update Command Data 

/d   Dump Intel® Management Engine Interface PCI Configuration Space. 

/p   Dump all PCI Configuration Space 

/t   Run Intel® QST Compliance test suite (Default) 

/Verbose Display Debug Information 

/Exp   Display Example Usage of the Tool 
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2.5 INI Files 

The package provides a single example configuration file named “QstCfgATXIP.ini”. 
This file configures Intel® QST to monitor and control the sensors and fan speed 
controllers that are available on the Customer Reference Board (CRB).  

This INI file can be used as the starting point of the configuration process. Most of the 
control parameters can be used as they are, except for certain hardware-dependent 
parameters. Those hardware-dependent parameters need to be modified by the 
designer to reflect specific hardware implemented on the platform. For example, 
device address of a sensor, how many fan headers implemented on the mother board, 
etc. 

Note: the Configuration Creation Wizard, which is also included in the ME firmware 
kit, can be used to easily create an initial INI file for a specific platform without using 
one of these initial INI files and modifying needed parameters. Refer to section 3.8 for 
more details. 

§ 
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3 Using the Intel® QST 
Configuration GUI 

This is a Graphical User Interface (GUI) used to edit Intel® QST Configuration (INI) 
files. It is a Win32 executable file. Via the traversable structure it presents, the 
configuration variables included in a INI file may be edited and then saved. 

Note: For Window* 2000 SP4 OS, the tool requires Microsoft MSVCP60.dll. Make sure 
MSVCP60.dll is installed on the system. 

The following sections describe in detail how to use the Configuration GUI. 

3.1 Start Up - License Agreement  

When the program is started, Intel’s license agreement is shown in a scrollable frame: 
 

  

Clicking “I Agree” will open the main program. Clicking “I Disagree” causes the 
program to exit. Checking “Do not show licensing on startup” before clicking on “I 
Agree” will disable the display of the License Agreement during subsequent 
invocations of the program. 
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3.2 Main Program 

The main frame of the GUI contains collapsible trees for each entity type. There are 
five entity types, categorized by functionality: Temperature Monitors, Fan Monitors, 
Voltage Monitors, Temperature Response Units, and Fan Controllers. 

Under each entity type is a collection of entities. There is an indication of how many 
entities are supported and how many of them are enabled. For example, (4/12) after 
the Temperature Monitors entity type in the figure below indicates that there are a 
total of 12 temperature monitors and that 4 of them are currently enabled. 

 

 

3.3 Accessing Entities within an Entity Type 

Each entity type, when expanded by clicking on the [+] symbol, will show all the 
entities available of that type. Each entity can be enabled or disabled by clicking on 
the white bar next to it and choosing an appropriate option from the pull-down list.  

As illustrated in the figure below, after expanding the Fan Monitors type, 8 Fan 
Monitor entities can be accessed. Each entity can be enabled or disabled through the 
pull-down list. 
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3.4 Editing Parameters 

When an entity is enabled, the parameters for that entity can be accessed by clicking 
on the [+] symbol. To edit the parameter, left-click into an edit bar and either enter 
or choose a new value from the pull-down list. 

Note that if an entity is disabled, the parameters for that entity cannot be edited. 
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3.5 Help Area 

The help area at the bottom of the main window conveys information about the 
selected entity or parameter. Information is provided in standard black text and status 
messages are provided in red. 
 

 

3.6 Menu Bar 
 

 

The menu bar of the GUI includes File, View, and Help. 

This section covers each menu option. A brief description for each menu item can also 
be seen in the status bar as the mouse cursor hovers over it. 
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File → New 

Values present in the various entities will be wiped (the user will be prompted to save 
these values if he has not done so) and replaced with a default set of values. Three 
types of default values exist (categorized by the form factor of the system being 
configured): 

• ATX: Set of Intel recommended defaults for ATX 

• BTX: Set of Intel recommended defaults for BTX 

• Custom: All fields are blank 

 

 

File → Load INI File… 

Values present in the entity records will be wiped (the user will be prompted to save 
these values if he has not done so) and replaced with values from an INI file chosen 
by the user. A popup will ask which form factor is desired. 

File → Save INI File… 

This option saves current values in the entity records to an INI file of the user’s 
choice. A popup box will be displayed if the Configurator finds issues with any field 
values (see figure below). The user has the option to Cancel in order to make edits 
before saving, or to Proceed and save with errors.  
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If an existing INI file is chosen, parameters will only be saved to it if they are 
changed. Comments in an existing INI file are preserved unless they are on line along 
with a parameter that is changed. 

File → Generate Configuration Payload… 

This option saves current values in the fields to a binary payload file (.BIN) of the 
user’s choice. A popup box will be displayed if the Configurator finds issues with any 
parameter values (see figure below). In this case, the user will have only the option to 
Cancel the Save operation, in order to make corrections before saving. The 
Configurator will only enable the option to proceed if the user’s data is error-free. 

 

 

File → Send Configuration to Firmware… 

This option sends the parameters directly to the firmware. As with “File → Generate 
Configuration Payload”, the user cannot deliver data to firmware if errors are found by 
the Configurator. 

File → Exit 

Choose this option to exit the program. 

View → Status Bar 

Toggles the visibility of the status bar at the bottom of the window 

 

 

View → Toolbar 

This option toggles the visibility of the toolbar right under the menu bar. 
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View → Expand All 

This option expands all tree nodes so that every parameter is made directly available. 
The scrollbar at the right of the window can be used to access parameters that are not 
immediately visible. 

View → Collapse All 

This option collapses all tree nodes so that only the root Entity Types are directly 
available. Clicking on the [+] symbol that marks a collapsible tree will expand the 
tree. 

 

§ 
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4 Using the Intel® QST 
Configuration Wizard 

The Intel® QST Configuration Wizard is a tool that facilitates the configuration of the 
Intel® QST INI file. The tool aids the user in establishing the initial control settings 
and connecting sensor addresses to variables used by Intel® QST.  The usage of this 
tool will primarily be by motherboard manufacturers or engineers responsible for 
configuring firmware within the motherboard.  This tool does not provide system level 
tuning, which is facilitated by the Intel® Quiet System Technology (QST) Tuning Tool 
available from the ME Firmware Kit. 

4.1 Installation 

To install the Intel® QST Configuration Wizard, initiate QstConfigurationWizard.msi 
and follow the step-by-step installation instructions. It is recommended that you 
install the Intel® QST Configuration Wizard to the default directory. 

4.2 Invocation 

The tool generates the INI file containing control parameters for a specific platforms 
based upon inputs from the board designers.  This INI file includes device addresses 
and commands used to read sensors and control fans.  The following screen images 
walk the reader through the usage of the wizard. 
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The Welcome screen will be the first screen the user will see once the Configuration 
Creation Wizard is started.  The next screen prompts the user to select the PCH and 
form factor of the board through the drop down windows.   
 

 



 
Using the Intel® QST Configuration Wizard 
 
 

  Intel Confidential 35 

Two standard form factors, ATX and BTX, are available to select from the drop down 
shown in the next figure.  These form factors encompasses all of the available sizes, 
such as micro-ATX.  For nonstandard form factors, the “Custom” option would be 
selected.  The form factor selection loads default settings that apply to the given form 
factor, such as PID settings. 
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The following figure shows Page 2 of the Wizard.  Page 2 prompts the user to add or 
remove SST devices.  If no SST devices are available, checking the check box in the 
upper left hand corner will disable the page.  On configurations where no prior ini file 
is loaded at the start of the wizard, the user will need to uncheck the check box to 
enable this page and add devices. 
 

 

In order to remove a device, the user must first select the device in the list as shown 
in the following figure to enable the Remove button.  Once the device is selected, 
pressing Remove will delete the device from the list and make the address available in 
the address window in the lower left hand corner of the page. 
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The next figure shows Page 3 of the Wizard.  Page 3 configures the Temperature 
Monitors.  Select the options from steps 1 through 4 on the screen and press the Add 
button to include additional Temperature Monitors.  In the event of an error, the 
Temperature Monitor may be modified by selecting the monitor in the list, making the 
change, then pressing update. 
 

 

Note that the Update button will be disabled until a change has been made to the 
parameters.  Likewise the Remove button is also disabled until a monitor is selected 
from the list. 
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Page 4 of the Wizard is shown in the following figure and configures the voltage 
monitors.  Note that the Voltage Monitor page will not appear if no SST 
devices have been added on Page 2.  Adding, modifying, and removing Voltage 
Monitors are conducted in the same manner as described previously with the 
Temperature Monitors. 
 

 

The following figure shows the Fan Monitor and Controller configuration.  Note that 
this page may appear as Page 4 if no SST devices for voltage monitoring have been 
added.  Interfacing with the page is similar to the previous pages.   In order to enable 
the Update and Remove buttons, one of the monitors must be selected.  Also a 
monitor must be available to configure in order for the Add button to be enabled. 
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The following figure shows the final screen which may be page 5 or 6 depending upon 
whether there were voltage monitors for the configuration.  The Wizard will 
automatically create an INI file named QstCfg.ini and save it to the root directory of 
the Wizard.  Select the Browse button to change the destination directory.  Two 
options for the configuration may be selected on this page.  A binary image may be 
generated by selecting the check box.  The binary file may be used to build a binary 
image for flash.  If the configuration was conducted on the QST system, selecting the 
last check box will put the new configuration into the QST subsystem. 
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Once the destination files are selected, press the Finish button and the Wizard will 
notify the user of successfully completing the configuration.  A dialog window will 
appear.  Clicking Close will close the window and the Configuration Creation Wizard. 

 

 

§ 
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5 Using the Intel® QST Tuning 
Wizard 

5.1 Installation 

In order to perform its tasks, the Intel® QST Tuning Wizard utilizes the services of a 
number of other facilities. As a result of these dependencies, the following installation 
process is necessary: 

1. Install the pertinent version(s) of the Intel® MaxPower Program. 

2. Install the Microsoft* .NET Framework. 

3. Install the Intel® QST Tuning Wizard. 

The Wizard requires Microsoft Windows XP (Service Pack 2), Windows Vista or 
Windows 7 operating system. 

5.1.1 Installing the Intel® MaxPower Program 

The Intel® MaxPower Program is used by the Intel® QST Tuning Wizard to place 
designated power loads on the processor. There are separate versions of this tool for 
each individual processor design. You should install versions for each and every 
processor design that you might utilize in your target systems. When you do so, it is 
required that you install them to their default installation folder (for example: 
C:\Program Files\Intel Corporation\Maximum Power Program for…); failing to do so 
will result in the Intel® QST Tuning Wizard being unable to locate and utilize their 
services. 

The executables for installing the MaxPower Program are distributed using file names 
that specify the Intel internal code name of the target processor. Versions for the 
Lynnfield and Havendale processors are included in the Manageability Engine 
Firmware Kits. They are not included in the Intel® QST Tuning Wizard installation 
package, however. 

5.1.2 Installing the Microsoft* .NET Framework 

The Intel® QST Tuning Wizard requires that v3.0 of the Microsoft* .NET Framework be 
installed on the target system. Because of its size, this framework is not included in 
the Manageability Engine Firmware Kits. The redistributable package for the 
framework can be downloaded from http://www.microsoft.com/downloads. 
Alternatively, the framework is an optional install available via Microsoft Update. 

http://www.microsoft.com/downloads/details.aspx?FamilyId=10CC340B-F857-4A14-83F5-25634C3BF043&displaylang=en
http://update.microsoft.com/microsoftupdate/v6/default.aspx
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5.1.3 Installing the Intel® QST Tuning Wizard 

Once you have the Microsoft* .NET Framework and appropriate version(s) of the 
Intel® MaxPower Program installed onto your target system, you can proceed with the 
installation of the Intel® QST Tuning Wizard.  

To install the Intel® QST Tuning Wizard: 

1. Initiate QstTuningWizard.msi. 

2. Follow the step-by-step installation instructions. It is recommended that you 
install the Intel® QST Tuning Wizard to the default directory. 

5.2 Usage 

The Intel® QST Tuning Wizard is a simplified user interface that provides the ability to 
find and set optimal tuning parameters and related configuration parameters. The 
functionality does not completely replace the other available Intel® QST tools, but 
provides a tool that will satisfy the System Integrator’s basic needs for finding the 
optimal parameter settings. 

The Intel® QST Tuning Wizard is a simplified integration tool to be used by System 
Integrators to adjust the base configuration for their system designs and automate the 
tuning of the fan speed control solution. Specifically, it allows the Integrator to set 
temperature limits, specify fan control settings, specify acoustic information on fans, 
automatically test and determine temperature-sensor-to-fan-weight parameters, 
specify and test the PID gain settings for the CPU and deliver the new settings to the 
Intel® QST subsystem and (optionally) write them to an output (.INI) file.  The Intel® 
QST Tuning Wizard also allows for the creation, alteration, and tuning of the 
parameters that implement the Sensor Based Specification for Neahlem based 
processors utilizing the Digital Temperature Sensor.  Additionally the wizard allows 
these new settings to activate and/or deliver the new settings to the Intel® QST 
configuration and (optionally) write them to an output (.INI) file. 
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5.2.1 Usage Process 

The process for using the Wizard and achieving the optimal settings for your system is 
visualized in Figure 1.  

Figure 1: Flowchart for Wizard Process 
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The Wizard steps through ten screens to complete the tuning process. Each screen 
and the options available are presented below.  Additional screens and features are 
added for the implementation of the Sensor Based Specification for Nehalem based 
processors.  These screens allow for the creation, alteration, and tuning of the Sensor 
Based specification using the Digital Temperature Sensor (DTS).  If the system 
running the Intel® QST Tuning Wizard does not support the Sensor Based 
Specification these additional screens are not visible and are not part of the tuning 
process. The standard QST functionality for temperature based fan speed control has 
not changed in this generation.  All associated .INI files and parameters have 
remained the same.  The DTS, RPM control capability has been added for the 
processor fan and it parameters are stored in a separate .INI file.  For more detailed 
information, see the Intel® QST Configuration and Tuning Manual. 

1. Welcome: Start-up screen. 

2. Tool Options: Screen used to specify initialization and data-recording parameters 
for the Wizard. 

• .INI File: By default, the active configuration is uploaded from QST and 
loaded into the current settings fields of the Intel® QST Tuning Wizard. 
Checking this checkbox allows the Integrator to use the File Open dialog to 
specify that an alternate configuration should be read from a particular .INI 
file and used in place of the current Intel® QST configuration. 

• Log File: By default, this checkbox is checked and the Intel® QST Tuning 
Wizard records data to the file “logfile.txt”, located in the directory where the 
Wizard was installed. Clicking the ‘Browse’ button allows the Integrator to use 
the File Open dialog to choose the folder and specify the name of the log file 
that will receive test data (temperatures, duty cycles and fan speeds). 
Unchecking the checkbox disables the logging of test data. 

• Digital Sensor Specification (DTS) Control: If the platform that Wizard is 
operating on has the capability to implement the Sensor Based Specification 
then this check box will appear.  If the DTS Control has NOT been configured 
nor enabled then the Tools Options screen appears as is show in Figure 2. 
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Figure 2: Tool Option Screen on System with DTS Control Capability but WITHOUT DTS 
Control Enabled 

 

 

• .INI FILE (Digital Sensor Specification (DTS) Control): By default, the 
active DTS control configuration is uploaded from QST and loaded into the 
current settings fields of the Intel® QST Tuning Wizard. Checking this 
checkbox allows the Integrator to use the File Open dialog to specify that an 
alternate configuration should be read from a particular .INI file and used in 
place of the current Intel® QST DTS configuration (Figure 3). 

• Log File (Digital Sensor Specification (DTS) Control): By default, this 
checkbox is checked and the Intel® QST Tuning Wizard records data to the file 
“logfileDTS.txt”, located in the directory where the Wizard was installed. This 
logfile location is determined by the location of the log file path as inputed in 
the “Saves plot data to a text file” check box above.  The path of this log file is 
altered to add a “DTS” to the end of the file name (Figure 3). 
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Figure 3: Tool Option Screen on System with DTS Control Configured and Loaded 

 

 

3. Temperature Settings: Screen used to configure the temperature monitor usage 
and the associated limit temperature. 

• Enabled Sensor: Checkboxes allow the Integrator to disable the use of 
particular temperature inputs. The Processor, G/MCH and ICH temperatures 
are of prime importance and cannot be disabled.  

Note: Disabling is a destructive process; if you exit from the Intel® QST Tuning Wizard, the 
configuration parameters for the temperature input will be lost and you will not be 
able to re-enable the temperature without directly modifying the .INI file and updating 
QST. See the Intel® QST Configuration and Tuning Manual for more information. 

• Usage: Specifies the source of the temperature that is associated with a 
monitor. For specific devices (Processor, G/MCH and ICH), support for 
modifying the usage indicator is disabled. Usage for other sensors may be 
modified as appropriate. 
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• Limit Temperature: Specifies the limit, or target, temperature that Intel® 
QST should attempt to maintain at the associated temperature sensor. 

4. Fan Controller Settings: Screen used to configure the fan controllers that are 
responsible for the determination of the duty cycle values that are sent to the 
fans. 

• Controller: Indicates the available Fan Controllers, as specified in the current 
Intel® QST Configuration or the specified .INI file. 

• Usage: Specifies the purpose for the fan controllers. The Integrator may 
change the usage to reflect the most accurate purpose for each fan controller. 

• Mode: Specifies the mode of operation for each fan controller. Two modes are 
supported: Min and Off.  

• In Min Mode, if the necessary duty cycle falls below the specified Min duty 
cycle, the duty cycle is held at this minimum and the fan(s) will remain 
spinning. 

• In Off Mode, if the necessary duty cycle falls below the specified Min duty 
cycle, the duty cycle will be set to 0 (zero) and the fan(s) will be stopped. 
Once stopped, the fan(s) will remain stopped until the necessary duty 
cycle exceeds the specified On duty cycle. 

Note: Off Mode is not supported by and is disabled for Fan Controller 1 (typically the 
processor fan controller).  

• Min Duty Cycle: Specifies the minimum duty cycle allowed for the specified 
fan. The Integrator can change this value if the fans that they are using either 
do not spin reliably at the current minimum setting or do not meet the idle 
airflow requirements. 

• On Duty Cycle: Specifies the duty cycle above which, if the fans are stopped, 
they are restarted. This parameter is ignored (and disabled) if operating in 
Min Mode. Specifies the duty cycle at which, if the fans are stopped, they are 
restarted. The value must be some amount higher than the Min Duty Cycle. 
The difference should be at least 2%, in order to ensure that the fans are not 
rapidly oscillating between the on and off states. 

• Max Duty Cycle: Specifies the maximum duty cycle allowed for the fan 
controller. This is typically 100%, but may be set to a lower percentage if 
there is a duty cycle range in which the fan(s) produce significantly higher 
acoustics without providing any significant improvement in cooling. 

• Signal Frequency: Specifies the frequency of the PWM output signal from the 
fan speed controller. For 3-wire fans, values from 10-94 Hz are typical, though 
new circuit designs are available that use frequencies in the 22-30 KHz range. 
For 4-wire fans, 22-30 KHz is typical. 

5. Fan Monitor Settings: Used to configure the operation of the fan monitors. 
The fan monitors are responsible for the determination of the health of the 
underlying fan sensor and the exposure of RPM readings from these sensors. 

• Fan: Indicates the available fan monitors, as specified in the current 
Intel® QST Configuration or the specified Intel® QST .INI file. 
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• Usage: Specifies the purpose for the fan that is being monitored. The 
Integrator may change the usage to reflect the most accurate purpose 
of the fan monitor. 

6. Weighting Inputs: Screen used to provide both required and optional data that 
is used in the weighting matrix optimization process. Fan acoustic data is included 
in the weighting matrix calculation in the next step. Intel® QST will de-prioritize 
louder and less-effective fans in favor of quieter and more-effective fans, 
respectively, to maintain the minimum system acoustic level. 

• Ambient Temperature: Specifies the ambient temperature of the test room. 
This is a required parameter. 

• Acoustic Units: Specifies the acoustic units of the fan acoustic data, if 
available. Four choices are possible: 

• No Acoustic Data: No data is available to use in this process. 

• Sound Power: Acoustic data was measured in BA. 

• Sound Pressure: Acoustic data was measured in db. 

• Relative Loudness: While acoustic measurement is preferred, subjective 
evaluation is acceptable. Selecting this option opens the Intel® QST 
Tuning Wizard fan test window, which allows the Integrator to take the fan 
controllers to 100% duty cycle in succession, keeping all other fan 
controllers at their respective minimum duty cycle setting. The Integrator 
can then subjectively assign the loudest fan controller a 100% relative 
loudness value and the other fan controller(s) appropriately smaller 
relative loudness value(s). 

• Acoustic Inputs: Specifies the measured acoustic level associated with each 
fan controller (in units chosen above). 

7. Weighting Calculations: Screen used to start the weighting calculation process.  

• Calculate Weights button: This button starts the weighting calculation 
process. Once started, this button can also be used to abort the process (its 
label will change to depending on the program state). This test finds the 
optimal power setting, and then sequentially tests the effectiveness of each 
fan to each temperature sensor.  This process can be skipped by clicking the 
next button.  If skipped the user can manually enter the weighting values or 
skip to the PID tuning section of the Wizard if the weighting calculation has 
previously been performed.  If the process is skipped the warning shown in 
Figure 4 will appear the weights stored in the QST subsystem will be loaded in 
the Weighting Calculation Results screen with a blue text color (Figure 5).  If 
the weighting calculation is performed the text color in the Weighting 
Calculation Results screen is black. 
 

Note: It is recommended to run the weighting calculation if it previously has not been 
performed. 
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Figure 4: Weighting Bypass Warning Message Box 

 

Figure 5: Weighting Calculation Results Screen After Skipping Process 

 

Note: This process may take 20-30 minutes to complete, depending on the system 
configuration, number of fans, etc.  
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Note: For best results, the tests should be run with no other programs active. The results 
depend heavily upon seeing constant power levels, generated specifically by the 
MaxPower program, and additional CPU load may alter results. 

Note: Some systems will either timeout or be over-temperature even at the lowest 
MaxPower setting. In the case of a timeout, it is recommended that the Integrator 
ignore the error and continue the test. If an over-temperature error is returned, the 
Integrator may choose to continue the test. If they do so, it is recommended that they 
monitor the system closely and abort the test if an excessive over-temperature 
situation occurs. In either case, the Integrator must ensure that each temperature 
monitor reaches steady-state for optimal weights to be calculated. 

8. Weighting Calculation Results: Screen that allows user to view and modify the 
calculated weighting parameters. These parameters are presented in a matrix. The 
active cells of this matrix can be edited to change these values; however, it is 
recommended that the calculated values not be modified.  Figure 5 shows the 
screen after the user has bypassed the weighting calculation process.  Upon 
completion of this screen by the click of the “Next” button, the values are checked 
to determine if each of the temperature sensors (e.g. “Sensor3”) has at least one 
fan controller (e.g. “Ctl 3”) that is equal to 100%.  If not the warning message in 
Figure 6 will appear.  Typical this will not occur if the weighting calculation process 
is run and not bypassed but can occur if the user alters the values or a sensor is 
active but unresponsive during the process. 

Figure 6: Warning Each Sensor Does Not Have At Least One Fan Controller with 100% 
Weighting 
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Figure 7: PID Gain Tuning Scene 

 

 

9. PID Gain Testing: Screen used to set, adjust, test and retest the PID gain 
settings for the processor. The selection of the PID (KP, KI, KD) gain settings is 
simplified using the Damping and Response parameter table. By analyzing the 
data created in this step, the gain settings can be adjusted to minimize the 
transient acoustics on your system. This step is iterative and will likely require the 
gain testing to be run multiple times. 

• Gain Presets: A pre-defined matrix of sets of PID gain settings that will 
provide good results across a broad range of systems. The default gain setting 
is (Damping = 1.0, Response = 1.0); this is the recommended settings for 
starting the test the first time. The corresponding P, I and D gain settings are 
displayed to the right of the slider bars below. 

• Maximum Temperature Overshoot: The maximum difference between the 
average steady-state condition and the peak across the response time 
domain. This parameter is displayed for the most recent gain test.  

• Maximum PWM Overshoot: The maximum difference between the average 
steady-state condition of the fan and its peak across the response time 
domain. This parameter is displayed for the most recent gain test. 

• Test Gains: Starts the gain testing routine, which takes the processor 
through three distinct power steps: from idle to high, from high to mid, and 
finally, from mid to high (see Figure 8). By analyzing the fan and temperature 
response at each of these power steps (marked by a gray vertical line on the 
plot), the gain settings can be adjusted to minimize the acoustics (see Section 
5.2.2 for guidance on adjusting the gain settings). 
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• Damping: Damping and Response parameters are a simplified representation 
of the PID gain settings. In general, increasing the Damping will decrease fan 
oscillation and decrease temperature overshoot. However, too high of a 
Damping will cause fan overshoot, causing higher acoustics than are 
necessary to adequately cool the system. 

• Response: Damping and Response parameters are a simplified representation 
of the PID gain settings. In general, increasing the Response causes the fans 
to react faster to a temperature change, thereby decreasing temperature 
overshoot. However, too high of a Response will cause fan overshoot and 
oscillation, causing higher acoustics than are necessary to adequately cool the 
system. 

• Enable Advanced Gain Tuning: If selected, allows user specify KP, KI and KD 
independent of the pre-defined ratios. If not selected, KP, KI and KD gain 
settings are automatically set via the selected radio button in the Gain 
Presets. Selecting this option gives the user greater flexibility to both have a 
wider range of gains, as well as independently changing the ratios between 
the gains. If settings produce undesirable results, the user can easily select a 
Damping and Response setting from the pre-defined matrix. 

Note: For more information on PID gain setting tuning, see Section 5.2.2. 
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10. DTS Specification Parameter Inputs: Screen allows the user to create or 
adjust the parameters associated with the Sensor Based Specification.  If the 
Sensor Based Specification of “DTS” control is active these values will be loaded 
from the Intel® QST configuration.  If it is not the user can manually enter these 
values.  Figure 8 shows this screen. 

• DTS Specification Parameters:  The values in this section are specific to the 
exact processor type and can be found in the processor specification. The 
performance target of the processor’s thermal solution in “Psi-ca” is 
determined based on the read DTS temperature of the processor and 
calculated based on a three parameter equation determined between Tcontrol 
(“DTS=Tcontrol”) and one degree below TCC activation (“DTS=-1”).  This 
equation has a slope, intercept and maximum ambient temperature values 
(which is the same at both points).  The exact equation and subsequent 
parameters can be found in the processor’s datasheet specifically in the 
Package Thermal Specification chapter in the Notes section of “Thermal 
Solution Performance above Tcontrol” table. 
 
These parameters determine the Psi-ca “Target” for the processor when its 
DTS temperature is above Tcontrol. 

• Processor Fan Monitor:  Fan controller associated with the processor using 
the Sensor Based Specification and that will be controlled when DTS is above 
Tcontrol. 

• Ambient Temperature Monitor:  The Psi-ca Target varies as ambient 
temperature varies and as such a temperature monitor can be specified. It is 
assumed that the temperature monitor is immediately upstream of the 
processor’s thermal solution within the system.  If there is ambient sensor 
available in the system then “No Sensor” can be selected and the specification 
with not vary with ambient temperature but will assume a constant 40 °C.  
Correction to the specific temperature sensor can be performed and the 
sensor’s slope and offset can be changed to adjust the sensor to represent the 
ambient temperature.  The Temperature Sensor corrected slope and offset are 
parameters that are stored in the main QST subsystem and are not uniquely 
part of the Sensor Based Specification implementation.   

o Corrected Slope:  Measured temperature value is read and multiplied 
by the corrected slope (in °C/°C).  The corrected offset, if any, is then 
applied and the temperature is reported. 

o Corrected Offset: Measured temperature value adjusted by the 
addition of the corrected offset (°C) after corrected slope is applied 
and reported 

• Heatsink Performance Information: This section contains the performance 
information for the active heatsink associated with the Processor Fan Monitor 
selected in the screen.  Specifically six data points are inputted for the thermal 
solution’s thermal performance in “Psi-ca” (in degree Centigrade per Watt or 
“C/W”) at a specified thermal solution’s “Fan Speed” (in Revolutions per 
Minute or “RPM”).  The thermal performance is determined with a Thermal 
Test Vehicle for which its specification is determined.   
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Please refer the processor’s datasheet and (specifically the Package Thermal 
Specification chapter) as well as the processor’s Thermal Mechanical Design Guide 
(specifically the Sensor Based Thermal Specification Design Guidance Chapter) for 
more details associated with the Sensor-Based Specification. 

Figure 8: DTS Specification Parameter Inputs Screen 

 

 

11. Processor DTS RPM Gain Tuning Screen:   Similar to the “PID Gain Testing 
Screen” used to set, adjust, test and retest the PID gain settings for the processor 
when in temperature control or below Tcontrol this screen allows tuning of the 
RPM PID gain settings when the processor is above Tcontrol.  

Note: To generate a temperature response that exceed the processors Tcontrol temperature 
testing may have to be performed at elevated temperatures.  This need is dependant 
on the processor specification as well as it’s power dissipation. 
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• DTS RPM Gain Presets: A pre-defined matrix of sets of PID gain settings 
similar to that of the temperature control PID gains may provide good results 
across a broad range of systems.  It is specific to the thermal solution 
implemented and its speed range.  The temperature control PID gains are a 
good place to start when testing DTS RPM control PID gains.  Typically a well 
tuned system will require less responsiveness and dampening (0.75x to 0.5x) 
when above Tcontrol.  The actual PID values are read from the QST 
configuration if the DTS specification has been implemented and is active.  
The corresponding P, I and D gain settings are displayed to the right of the 
DTS RPM Gain Presets section. 

• Enable Advanced Gain Tuning: If selected, allows user specify P, I and D 
independent of the pre-defined ratios. If not selected, P, I, and D gain settings 
are automatically set via the selected radio button in the Gain Presets. 
Selecting this option gives the user greater flexibility to both have a wider 
range of gains, as well as independently changing the ratios between the 
gains. If settings produce undesirable results, the user can easily select a 
Damping and Response setting from the pre-defined matrix. 

• Damping: Damping and Response parameters are a simplified representation 
of the PID gain settings. In general, increasing the Damping will decrease fan 
oscillation and decrease RPM overshoot. However, too high of a Damping will 
cause fan overshoot, causing higher acoustics than are necessary to 
adequately meet the sensor based specification. 

• Response: Damping and Response parameters are a simplified representation 
of the PID gain settings. In general, increasing the Response causes the fans 
to react faster to a temperature change and a subsequent RPM target, thereby 
decreasing RPM overshoot. However, too high of a Response will cause fan 
RPM overshoot and oscillation, causing higher acoustics than are necessary to 
meet the sensor based specification. 

• Test DTS RPM Gains: Starts the gain testing routine, which takes the 
processor through three distinct power steps: from idle to very high, from 
very high to high, and back to very high.  By analyzing the fan and RPM 
response at each of these power steps, the gain settings can be adjusted to 
optimize the systems performance. 

• Maximum RPM Overshoot: The maximum difference between the average 
steady-state condition of the fan and its peak across the response time 
domain. This parameter is displayed for the most recent gain test. 

• Average Difference From Target: During the test a “Target RPM” is 
displayed along side the thermal solution’s actual fan speed to compare how 
well the PID gains are controlling the thermal solution.  If the DTS 
temperature is below Tcontrol it would be expected to see a Target RPM value 
above what the solution is actively spinning at.  Above Tcontrol the control 
logic is seeking to meet the target RPM speed.  This reports the average 
difference the fan speed is from the specification’s targeted speed when the 
processor is above its Tcontrol. 

• Processor Throttle Detected: Number of seconds a throttle or TCC event is 
detected during the test.  The sensor based specification allows processor 
temperatures above Tcontrol which is an acoustic benefit to the end user but 
may place the processor closer to its Throttle or TCC activation temperature. 
If the PID values are implemented that don’t not respond to DTS temperature 
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changes fast enough the processor may reach this throttle temperature.  If 
significant throttle time is witness then increasing the responsiveness of the 
PID rpm gains is recommended. 

Figure 9: Processor DTS RPM Gain Tuning Scene 
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12. Exit Screen: Screen allows user to save and implement settings.  If the Digital 
Sensor Specification (DTS) Control check box is NOT checked in screen 2 then 
screens 10 and 11 are not show and this becomes screen 10  

• Update QST on exit: Sends the final version of the configuration to QST for 
storage (overwriting previous settings).  If the Sensor Based Specification DTS 
control has been activated and tuned then it parameters will be saved as well. 

• Update .INI on exit: Writes settings to the .INI file that was specified in the 
“Tool Options” screen. If the Sensor Based Specification DTS control has been 
activated an additional .INI file is written as specified in the “Tool Options” 
screen. 

• Create new .INI on exit: Writes settings to a new .INI file. The Integrator 
will specify the filename and directory in a File Open dialogue. If the Sensor 
Based Specification DTS control has been activated an additional File Open 
dialogue is seen to save the separate DTS .INI file. 

5.2.2 PID Gain Setting Tuning 

While much of the Wizard is automated, user input is required to find the optimal gain 
settings. The default gain settings may be adequate for many systems, but fine-tuning 
the gain settings to your particular system (and especially its processor cooling 
solution) can provide an additional acoustic benefit. This section describes the process 
for adjusting the PID gain settings in Screen 9: PID Gain Testing.  Although these 
guidelines are focused on the temperature PID gains they also apply in general to the 
tuning of the DTS RPM control PID gains and should help guide the tuning of those PDI 
gains as well. 

5.2.2.1 Determining the Quality of PID Gain Settings 

Certain metrics can be used to measure the quality of your fan speed and temperature 
response to determine if you have optimized gain settings. Analyzing the fan speed 
and temperature response to multiple inputs can help you to determine (1) if your 
current gain settings are appropriate, and (2) how to change the gains to achieve 
better results. The Intel® QST Tuning Wizard automates both changes in processor 
power and data collection to enable the Integrator to assess the response quality to 
changes in power. 

5.2.2.2 Assessing Response Quality 

The first measures of response quality are indicated in the upper right corner of Figure 
1: the Maximum Temperature Overshoot and the Maximum Fan Overshoot. If either of 
these values are large (>4 °C or > 5% PWM, respectively) then the user should 
change the gains and retest. See Table 1 for recommendations on changing the gain 
settings. 
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The second measure is analysis of the temperature and fan PWM response data from 
the PID gain settings test. Figure 11 - Figure 13 show the response of a relatively 
simple one fan, one sensor system while subjected to the series of changes in 
processor power shown in Figure 10. These power changes, moving from left to right, 
are as follows: 

1. Start power at idle setting 
2. Increase power to a high power setting 
3. Reduce power to an intermediate power setting 
4. Increase power to the high power setting again. 

This series of power changes will stress the fan speed control subsystem and expose 
any problems with its dynamic control. In particular, the response at power steps 1-
to-2 and 3-to-4 will provide the response data of interest. The results (Figure 11-
Figure 13) can be used to illustrate how to measure the quality of fan and 
temperature response. Table 1 explains the metrics shown in Figure 11-Figure 13. 

Figure 10: Power Level Changes for the PID Gain Settings Test 
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Figure 11-Figure 13 show response data from a real system with only one fan and the 
CPU temperature response shown. The indicators of poor PID Gain Settings are 
highlighted and an improvement path is suggested. 
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Figure 11: Fan Overshoot & Temperature Oscillation (Adjustment: Decrease Response) 
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Figure 12: Temperature Overshoot (Adjustment: Increase Both Damping and 
Response) 
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Figure 13: Fan Spike, Temperature and Fan Overshoot (Adjustment: Decrease 
Damping) 
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Table 1: PID Gain Setting Adjustment Guide 

Metric Description How to Improve Problem 

Fan and/or 
Temperature 
Oscillation 

The fan or temperature response 
oscillates above and below it’s 
steady-state condition when the 
power is not changing 

Decrease Response and 
Increase Damping 

Fan 
Overshoot 

The maximum delta between the 
average steady-state condition of 
the fan and it’s peak across the 
response time domain 

Decrease Response and 
Damping 

Temperature 
Overshoot 

The maximum delta between the 
average steady-state condition of 
the temperature sensor and it’s 
peak across the response time 
domain 

Increase Response and 
Damping 

Fan and 
Temperature 
Overshoot 

During certain power changes the 
fan speed increases above its 
steady state condition, but at other 
parts of the test, the temperature 
increases above its steady state 
condition 

Increase Response and 
decrease Damping 
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5.2.2.3 Process for Adjusting the PID Gain Settings 

Once the response data is analyzed and the problem areas identified, the Damping 
and Response parameters can be changed to improve performance. The process for 
tuning the gain settings is as follows: 

1. Choose a set of gain values for initial testing from the Gain Preset table. The 
default settings are a good place to start.  

2. Run the gain test on the Processor Gain Tuning screen. 

3. Analyze the data and identify the key indicators as described in Section 5.2.2.2. 

4. Use the information presented in Figure 11-Figure 14 and Table 1 to determine if 
the PID gain settings are adequate and, if not, how to adjust the Damping and 
Response to improve the results. For example, if the test was run using the 
default settings, and the results in Figure 12 were achieved, the temperature 
overshoot would need to be decreased. Referring to Figure 15, this response 
indicates moving both the Damping and Response parameters up and to the right 
is necessary (i.e. away from the ‘Too Much Temperature Overshoot’ corner). Thus, 
the button at (Damping = 1.5, Response = 1.5) should be selected. After making 
any change, the Gain Tests should be run again to verify the new settings. 

Note: This method works for any starting point. Suppose a second test was run and the data 
indicated that there was too much fan oscillation. For fan oscillation, the plot 
recommends moving down and right. When the starting point is (1.5, 1.5), the next 
setting to test would be (2.0, 1.0), and so on. It is also acceptable to move 
horizontally or vertically on the chart if multiple indicators are found. 

Repeat the test, analyze and adjust process (steps 1-4) until good Damping and 
Response settings are found. This is indicated by none of the symptoms described in 
Table 1 being present in the data, a temperature overshoot of <4°C and a fan 
overshoot of <5% PWM. Figure 14 shows the response of a well-tuned system. 

Figure 14: Response from Tuned PID Gain Settings 
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Figure 15: PID Gain Setting Adjustment Guide 
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5.2.3 Using the Plot Window 

The QST Plot window offers several functions to help the user see the data as it is 
collected in real time and in a useful manner. 

5.2.3.1 Plot Window Contents 

The Plot Window shows three separate sets of data vs. time while the testing 
proceeds: 1) the temperature for each enabled temperature sensor, 2) the fan 
controller PWM, and 3) the fan monitor RPM. These are displayed top-to-bottom in the 
window. Figure 11-Figure 14 all represent examples of the contents of the 
temperature portion of the plot display. 

5.2.3.2 Plot Window Options 

The features enabled in the plot window are as follows: 

• For both the x- and y-axis: 

• Can be panned by grabbing and dragging. 

• Right click context menu can enable/disable tracking and zoom to fit the 
data displayed. 

• Zoom in on data. To zoom, click the ‘Zoom On’ button in the lower right side 
of the plot of interest, then select a rectangle around the data of interest. 
Cursor must start in the upper-right corner of the rectangle. Click the button 
again (now titled ‘Zoom Off’) to return to the full data set. 

• Hide and unhide channels. Click on the channel of interest in the legend and 
answer ‘Yes’ in the dialogue box to hide a channel. Repeat process to unhide 
channel. 

5. Clicking on ‘No’ when hiding or unhiding a channel will open a color selection 
dialogue to change the color of the channel. 

• The window can be resized as desired. Each plot will take 1/3 of the height 
and the full width of the window. 
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